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Step 1 - Have Windows Computer
It is recommended that you obtain a freshly installed Windows computer. It’s wise to purchase an inexpensive $300 laptop for this course. Even with a fresh new laptop just in two weeks of web browsing I had Trojans and viruses that affected my database installs. Use a freshly installed computer before installing your databases. If you can’t then your database installs might NOT be successful. If you’re willing to take that risk, do your best to quarantine, repair, and recover to get it back to what it was when you purchased it from the store PLUS any mandatory Windows updates.


Step 2 - No Java Installations
Java is used by the databases you’ll be installing. Any Java previously installed may affect your installations. Do not install Java before hand.


Step 3 - No Corrupted System
As a practice you should always confirm you have an uncorrupted system. Corruption can be from various sources like bad bad software installs, invalid registry entries, files with checksums that don’t match, and even files that are missing. To confirm you have no corrupted files, type cmd in the search bar located at the bottom left side of the screen. That will open up DOS window. In the DOS window type sfc/scannow. This scan will take a while.


Step 4 - Create Recovery Drive
As a practice you should always have a USB recovery drive for your laptop. DO NOT rely on the recovery partition on your computer. Always make sure you have an external drive for your recovery. Plug in an empty USB drive with a minimum of 16G. In the search bar at the bottom left of your screen type create recovery drive. Then click on Create a Recovery Drive located at the top left. Follow the instructions. The creation can take several hours. It took me 5 hours to create mine. If you cannot create the recovery drive then it’s likely you either have a bad USB drive, corrupted files, or defective hardware. Confirm if it’s the USB drive or if it’s the computer. If it’s your computer then you’ll likely need a new computer.


Step 5 - Create Backup Disk Image
As a practice you want to be able to restore your computer to a pervious point where it was working. The best way to do this is by creating a backup of your computer’s disk images. My Oracle installation failed twice. Without the backup images I would not have been able to restore my computer and successfully install Oracle. To create your backup images you will install fMacrium Reflect. It is located at https://www.macrium.com/reflectfree. Use Macrium Reflect to create a bootable rescue media disk. The option is located under other tasks. Used a second USB drive for this. Then backup your disk images to that USB drive by selecting all of your disks and clicking image this disk. Give your image name a meaningful name. My images names are default and cst2355.


Step 6 - Install Oracle Database
Oracle, unlike the other databases, has multiple software to install. To install the Oracle database go to https://www.oracle.com/database/technologies/xe-downloads.html. Download the file. Extract the file.


Go to the folder you created and double-click/run the Oracle Database 18c Express Edition file. Make sure you have a good internet connection. And DO NOT run any other applications or do anything on your computer while Oracle is installing. The Oracle install is sensitive. With one hick up you will not be able to complete an Oracle install without restoring your laptop with your backup image.


The install will prompt you to create a password. Use CST23Da as your SYSTEM password. You may get a Windows Security Alert about the Java Platform SE binary. Allow access IMMEDIATELY. Having this alert sit too long may affect your install. I allowed access for both Private networks and Public networks.


Now you’re going to test your Oracle is working. Type cmd in the search bar and open a DOS window. Type in sqlplus system at the DOS prompt. For your password type CST23Da


You should see...
Oracle Database 18c Express Edition Release 18.0.0.0.0 - Production
Version 18.4.0.0.0


Now you will setup Oracle to create a schema (user) for each assignment. You type in the following in SQLPLUS.


alter session set "_ORACLE_SCRIPT"=true;
create user assign_1;
create user assign_2;
create user assign_3;
create user assign_4;
create user assign_5;


Close the DOS screen. Start the OracleOraDB18Home1TNSListener service if it isn’t running. You get to the services settings by typing services in the start bar.


Step 7 - Update LISTENER.ORA
Confirm that the listener is up and running. Type cmd in the search bar and open a DOS window. Type in lsnrctl status at the DOS prompt. Confirm that there are no errors.


Locate your listener.ora file found under ORACLE_HOME\network\admin. ORACLE_HOME is the path where you installed Oracle. Search your computer for the listener.ora file. Once found, make a copy of it. Name the copy listener-backup.ora.


Open the listener.ora using and editor. You should see something similar to the following.


# listener.ora Network Configuration File: C:\app\PC\product\18.0.0\dbhomeXE\NETWORK\ADMIN\listener.ora
# Generated by Oracle configuration tools.


DEFAULT_SERVICE_LISTENER = XE


SID_LIST_LISTENER =
(SID_LIST =
(SID_DESC =
(SID_NAME = CLRExtProc)
(ORACLE_HOME = C:\app\PC\product\18.0.0\dbhomeXE)
(PROGRAM = extproc)
(ENVS = "EXTPROC_DLLS=ONLY:C:\app\PC\product\18.0.0\dbhomeXE\bin\oraclr18.dll")
)
)


LISTENER =
(DESCRIPTION_LIST =
(DESCRIPTION =
(ADDRESS = (PROTOCOL = TCP)(HOST = 192.168.0.14)(PORT = 1521))
(ADDRESS = (PROTOCOL = IPC)(KEY = EXTPROC1521))
)
)


Add an XE SID. Select the first entry and copy it.


# listener.ora Network Configuration File: C:\app\PC\product\18.0.0\dbhomeXE\NETWORK\ADMIN\listener.ora
# Generated by Oracle configuration tools.


DEFAULT_SERVICE_LISTENER = XE


SID_LIST_LISTENER =
(SID_LIST =
(SID_DESC =
(SID_NAME = CLRExtProc)
(ORACLE_HOME = C:\app\PC\product\18.0.0\dbhomeXE)
(PROGRAM = extproc)
(ENVS = "EXTPROC_DLLS=ONLY:C:\app\PC\product\18.0.0\dbhomeXE\bin\oraclr18.dll")
)
)


LISTENER =
(DESCRIPTION_LIST =
(DESCRIPTION =
(ADDRESS = (PROTOCOL = TCP)(HOST = 192.168.0.14)(PORT = 1521))
(ADDRESS = (PROTOCOL = IPC)(KEY = EXTPROC1521))
)
)


Paste what you copied as the second entry.


# listener.ora Network Configuration File: C:\app\PC\product\18.0.0\dbhomeXE\NETWORK\ADMIN\listener.ora
# Generated by Oracle configuration tools.


DEFAULT_SERVICE_LISTENER = XE


SID_LIST_LISTENER =
(SID_LIST =
(SID_DESC =
(SID_NAME = CLRExtProc)
(ORACLE_HOME = C:\app\PC\product\18.0.0\dbhomeXE)
(PROGRAM = extproc)
(ENVS = "EXTPROC_DLLS=ONLY:C:\app\PC\product\18.0.0\dbhomeXE\bin\oraclr18.dll")
)


(SID_DESC =
(SID_NAME = CLRExtProc)
(ORACLE_HOME = C:\app\PC\product\18.0.0\dbhomeXE)
(PROGRAM = extproc)
(ENVS = "EXTPROC_DLLS=ONLY:C:\app\PC\product\18.0.0\dbhomeXE\bin\oraclr18.dll")
)
)


LISTENER =
(DESCRIPTION_LIST =
(DESCRIPTION =
(ADDRESS = (PROTOCOL = TCP)(HOST = 192.168.0.14)(PORT = 1521))
(ADDRESS = (PROTOCOL = IPC)(KEY = EXTPROC1521))
)
)


Select the below below and delete them.


# listener.ora Network Configuration File: C:\app\PC\product\18.0.0\dbhomeXE\NETWORK\ADMIN\listener.ora
# Generated by Oracle configuration tools.


DEFAULT_SERVICE_LISTENER = XE


SID_LIST_LISTENER =
(SID_LIST =
(SID_DESC =
(SID_NAME = CLRExtProc)
(ORACLE_HOME = C:\app\PC\product\18.0.0\dbhomeXE)
(PROGRAM = extproc)
(ENVS = "EXTPROC_DLLS=ONLY:C:\app\PC\product\18.0.0\dbhomeXE\bin\oraclr18.dll")
)


(SID_DESC =
(SID_NAME = CLRExtProc)
(ORACLE_HOME = C:\app\PC\product\18.0.0\dbhomeXE)
(PROGRAM = extproc)
(ENVS = "EXTPROC_DLLS=ONLY:C:\app\PC\product\18.0.0\dbhomeXE\bin\oraclr18.dll")
)
)


LISTENER =
(DESCRIPTION_LIST =
(DESCRIPTION =
(ADDRESS = (PROTOCOL = TCP)(HOST = 192.168.0.14)(PORT = 1521))
(ADDRESS = (PROTOCOL = IPC)(KEY = EXTPROC1521))
)
)


Select the SID NAME below and rename it to XE.


# listener.ora Network Configuration File: C:\app\PC\product\18.0.0\dbhomeXE\NETWORK\ADMIN\listener.ora
# Generated by Oracle configuration tools.


DEFAULT_SERVICE_LISTENER = XE


SID_LIST_LISTENER =
(SID_LIST =
(SID_DESC =
(SID_NAME = CLRExtProc)
(ORACLE_HOME = C:\app\PC\product\18.0.0\dbhomeXE)
(PROGRAM = extproc)
(ENVS = "EXTPROC_DLLS=ONLY:C:\app\PC\product\18.0.0\dbhomeXE\bin\oraclr18.dll")
)


(SID_DESC =
(SID_NAME = CLRExtProc)
(ORACLE_HOME = C:\app\PC\product\18.0.0\dbhomeXE)
)
)


LISTENER =
(DESCRIPTION_LIST =
(DESCRIPTION =
(ADDRESS = (PROTOCOL = TCP)(HOST = 192.168.0.14)(PORT = 1521))
(ADDRESS = (PROTOCOL = IPC)(KEY = EXTPROC1521))
)
)


Now you need to rename your HOST to the name of your computer. For host you will need to look it up on your computer. Run the cmd command in the start bar. Type hostname at the DOS prompt. Copy and paste the hostname you see to the HOST’s value in the listener.ora file.


# listener.ora Network Configuration File: C:\app\PC\product\18.0.0\dbhomeXE\NETWORK\ADMIN\listener.ora
# Generated by Oracle configuration tools.


DEFAULT_SERVICE_LISTENER = XE


SID_LIST_LISTENER =
(SID_LIST =
(SID_DESC =
(SID_NAME = CLRExtProc)
(ORACLE_HOME = C:\app\PC\product\18.0.0\dbhomeXE)
(PROGRAM = extproc)
(ENVS = "EXTPROC_DLLS=ONLY:C:\app\PC\product\18.0.0\dbhomeXE\bin\oraclr18.dll")
)


(SID_DESC =
(SID_NAME = XE)
(ORACLE_HOME = C:\app\PC\product\18.0.0\dbhomeXE)
)


)


LISTENER =
(DESCRIPTION_LIST =
(DESCRIPTION =
(ADDRESS = (PROTOCOL = TCP)(HOST = <paste HOST here>)(PORT = 1521))
(ADDRESS = (PROTOCOL = IPC)(KEY = EXTPROC1521))
)
)


Save and close the listener.ora file. Reboot your computer.


Confirm that the listener is up and running. Type cmd in the search bar and open a DOS window. Type in lsnrctl status at the DOS prompt. Confirm that there are no errors.
Step 8 - Install Oracle SQL Developer
Your next step is to install SQL Developer. This tool allows you to create and run SQL. Go to https://www.oracle.com/ca-en/tools/downloads/sqldev-v192-downloads.html
Select the download for Windows 64-bit with JDK 8 included. Download the file. Extract the file. Go to the folder you created and double-click/run the sqldeveloper file.


In SQL Developer, create a new connection by clicking on the green plus sign located at the left upper corner.


For Username type system
For Password type CST23Da
For Port type 1521
For SID type XE


For Hostname you will need to look it up on your computer. Run the cmd command in the start bar. Type hostname at the DOS prompt. Copy and paste the hostname you see to the Hostname field in SQL Developer.


Click Connect to create your connection.


Please note that if your working connection stops working it can mean the TNS Service isn’t running, your password changed, or the name of your computer changed.


Step 9 - Install Oracle SQL Developer Data Modeler
Now your ready to install SQL Developer Data Modeler. It is a tool that helps you design data models and database designs. To install SQL Developer Data Modeler go to... https://www.oracle.com/tools/downloads/sql-data-modeler-downloads.html. Select the download for Windows 64-bit with JDK 8 included. Download the file. Extract the file. Go to the folder you created and double-click/run the datamodeler file.


Step 10 - Install MySQL
mySQL is just one installation that handles the intallations of multiple products. To install mySQL go to https://dev.mysql.com/downloads/windows/installer/.Then run the downloaded file.


While installing, make sure you click execute to meet most requirements. Once you get to the Accounts and Roles step, add the following user...


For User type CST23
For Password type CST23Da


Once installation completes, go to MySQL Workbench using the start bar. If you do not see a connection screen, reconnect to the database. It is the database icon located half a centimeter below the Tools menu option. Use CST2355 as your username and CST2355Database as your password. Through the menu, select File -> New Query Tab. Type the following in the query tab and execute it using the lightning bolt icon to create a schema for each assignment.


create schema assign_1;
create schema assign_2;
create schema assign_3;
create schema assign_4;
create schema assign_5;


Step 11 - Install SQL Server
SQL Server has two products to install. The server and the SSMS tools. For SQL Server go to
https://www.microsoft.com/en-ca/sql-server/sql-server-downloads. Select the Developer download and run the downloaded file.


To download SQL Server Management Studio (SSMS) go to https://aka.ms/ssmsfullsetup and . run the downloaded file.


To create the schemas for each assignment, run Microsoft SQL Server Management Studio 18 using the start bar. Make sure you’re connected to the Database Engine with the Server Name being Desktop. Use the Connect drop down to establish a connection if needed. Click on the New Query icon that is half a centimeter below the Tools menu option. Type in the following to create a schema for each assignment.


create schema assign_1;
go
create schema assign_2;
go
create schema assign_3;
go
create schema assign_4;
go
create schema assign_5;
go


Step 12 - Second Backup Image
Now that you’ve completed your installs, create another backup image of your computer and store it on your rescue media USB disk.


Step 13 - Start Your Assignment
It’s time to start your assignment. This assignment will help you determine your starting baseline for database design. This assignment will also give you a glimpse of the trade offs between designing tables and queries; and how designing one will complicate the design of the other.



